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1.0 INTRODUCTION 

 
After installing the RASPLOT program the user needs to select the version of HEC-RAS program 
to run with the RASPLOT.  It is explained under HEC-RAS Program Setup section.  HEC-RAS 
program must have RASPLOT user table under the User Tables menu in Profile Output Table 
window of HEC-RAS.  How to accomplish this task is explained under RASPLOT User Table 
section.  A HEC-RAS report file for RASPLOT must be created in order for RASPLOT to extract 
data in creating Profile Table Database.  It is explained under HEC-RAS Report File for 
RASPLOT section.  The components of the Profile Table Database are explained in Chapter 2, 
The Profile Table Database. 

 
1.1 What Is RASPLOT? 
 
RASPLOT is a computer program that creates a Flood Insurance Study (FIS) profile by 
automatically extracting data from HEC-RAS or HEC-2 input and output files.  In addition, the 
RASPLOT program can be used to create FIS profiles for any other hydraulic model by entering 
the necessary data manually.  The final product will be in DXF file format and a CADD program 
is included as part of this program to edit and print profiles as necessary. 
 
1.2 System Requirements 

 
In order to run, RASPLOT requires: 

• Windows 98/NT/2000/XP operating systems 
• Microsoft compatible mouse  
• Printer  
• SVGA graphics card and monitor. 

 
1.3 Program Installation 
 
Please note:  The user must initially uninstall any previous versions or Beta versions of 
RASPLOT.  For guidance on uninstalling previous versions of RASPLOT, see section 1.4. 
 
To install RASPLOT from a CD-ROM: 
 

The setup program in the setup.exe file runs from a CD-ROM.  On most systems, the 
CD-ROM is drive D.  The following steps refer to drive D.  If necessary, substitute the 
appropriate drive letter for D. 
 
1. Insert the CD in the appropriate drive. 
 
2. Select Windows 98/NT/2000/XP Start button, choose Run, designate the CD-ROM, 

and enter the path name and setup (for example, D:\setup).   
 

To stop the setup program, choose Cancel.  If you cancel the setup program after 
copying has begun, all files copied by the setup program will be removed. 

 
3. RASPLOT displays “C:\Program Files\Rasplot” as the path.  Accept the default 

destination location by clicking the upper right button, or use the Change Directory 
button to choose a different location. 

 
To install RASPLOT from the Internet: 
  

1. Download the setup.zip file from the FEMA web site at 
http://www.fema.gov/fhm/frm_soft.shtm to a local directory (e.g., C:\temp) on your 
computer's hard drive. 
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2. Extract setup.exe file from the setup.zip file in your local directory.  

 
3. Double click on Setup.exe  and follow the instructions on the screen to install the 

program.  
 
 
When the installation is complete, the following window will be displayed. 
 

 
 

• Click the Finish button.  
 

The RASPLOT program is installed under C:\Program Files\Rasplot, and the 
following files should be in the RASPLOT folder.  The files can be viewed using 
Windows Explorer. 
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To place the RASPLOT icon on the Desktop window: 
 

1. Click the Start button from the Windows Task bar => Programs => RASPLOT.  
 
2. Right click the mouse and select Send to folder => Desktop and left click the 

mouse.  
 

1.4 Uninstalling RASPLOT 
 

The following steps should be followed to uninstall any previous version of RASPLOT, or Beta 
versions of RASPLOT: 

 
1. From the Windows Taskbar, click the Start button => Settings => Control Panel. 

 
2. From the Control Panel, double click Add/Remove Programs. 

 
3. From the list of programs, select RASPLOT. 

 
4. Choose Add/Remove. 

 
5. In the confirmation dialog box, choose Yes. 

 
All of the program files that were part of the installation will be removed.  Files that were created 
in the RASPLOT folder after RASPLOT was installed will not be removed. 

 
1.5 HEC-RAS Program Setup 

 
This section explains how to select the proper version of HEC-RAS to run with the RASPLOT 
program.  The user is required to locate the HEC-RAS program file (i.e., ras.exe) through the 
RASPLOT Program. 
 

1. Double click the RASPLOT icon to run RASPLOT.  After the opening window, the 
following window will be displayed.  This is the main RASPLOT Program window. 

 

  
 

2. Click the File menu. 
 
3. From the list of displayed options, click Setup Program. 

 
4. The following dialog box will be displayed.  When the dialog box first opens, the 

HEC-RAS Program box and Default Data Directory box will be empty. 
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5. Click the upper Browse button to locate the ras.exe file of the HEC-RAS version to 
be used.    

 
6. Click the lower Browse button to select the default directory where the HEC-RAS 

files will be located.  This step is optional. 
 
7. Click OK. 

 
The HEC-2 program was already installed in the C:\Program Files\Rasplot during the installation 
process. 
 
1.6 RASPLOT User Table 
 
This section explains how RASPLOT creates the RASPLOT table in the HEC-RAS Program’s 
User Tables menu.  First, check to see whether there already is a User Tables menu on the menu 
bar of the Profile Output Table window of HEC-RAS.  If there is, skip to the RASPLOT User 
Table subsection below (subsection 1.6.2).  If not, follow the procedure described below 
(subsection 1.6.1) to create one. 
 

1.6.1 Create a HEC-RAS User Tables menu 
 
1. From the HEC-RAS main window, click Profile Table button (third button from the 

right in HEC-RAS 3.1.2 version).  The following window will be displayed. 
 

  
 

Note that there is no User Table menu on the menu bar, and Standard Table 1 is 
displayed as a default.  (The name of the Table displayed is shown on the header of the 
window.) 
 
2. Click Options menu.  
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3. From the list of displayed options, click Save Table.  The following dialog box will 
be displayed. 

 

  
 

Change the name to Table 1 by deleting (using the delete key) the unnecessary letters 
from “Standard Table & 1,” as shown below. 
 

  
 

4. Click OK.  The following window will be displayed. 
 

   
 

Note that User Tables menu is displayed on the menu bar, and Table 1 is displayed on 
the header of the window.  Table 1 will be displayed as an option when the User Tables 
menu is clicked. 
 
5. Close the Profile Output Table window. 
 
6. Close HEC-RAS main window. 

 
1.6.2 Create a RASPLOT User Table 

 
Follow the procedure described below to create a RASPLOT table in the HEC-RAS 
Program’s User Tables menu. 

 
1. Delete the file with extension “.rep,” if there is one, from the directory where the 

user’s HEC-RAS files reside. 
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2. Run RASPLOT (double click the RASPLOT icon). 
 
3. From RASPLOT Program window, click the Open button.  The following dialog 

box will be displayed.  (The files displayed will be the ones on the user’s computer).  
 

  
 

In the Open File window, as a default, HEC-RAS will be the selected mode in the Select 
a model area.  Locate the folder where the HEC-RAS files reside by browsing through 
the folders in the right box.  All the HEC-RAS project files (files with extension “.prj”) 
in that folder will be displayed in the left box, as shown below. 
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4. Double click the HEC-RAS project file to be studied or select the HEC-RAS project 
file and click OK. 

 
5. From the RASPLOT Program window, click the Extract button.  The following 

message box will be displayed. 
 

  
 

(As a default, HEC-RAS assigns the project file name as the primary name of all the 
HEC-RAS files).  Click Yes. 

 
The HEC-RAS main window for the version that was selected (see Section 1.5) will be 
displayed, as shown below, with the selected HEC-RAS project from the previous step. 

 

   
 

6. From the HEC-RAS main window, click Profile Table button.  (For HEC-RAS 
3.1.2, it is the third button from the right.)  The Profile Output Table window with 
the Standard Table 1 will be displayed. 

 
7. Click User Tables menu and click RASPLOT.  The RASPLOT table will be 

displayed, as shown below. 
 

 
  
The above procedure explains how RASPLOT creates a RASPLOT user table in the HEC-RAS 
User Tables menu.   Do not attempt to create a RASPLOT user table through the HEC-RAS 
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program by selecting the variables.  If for any reason, a RASPLOT table no longer exists in the 
User Tables menu, follow the above procedure to recreate one. 
 
Table Cross Section Order 
 
The River Stations (RS) in the RASPLOT table must be from upstream to downstream direction.  
RASPLOT extracts data not only from the RASPLOT table, which is the output data, but also 
from HEC-RAS input data: plan data, geometric data, and reach lengths.  The order of the RS of 
the input data in the HEC-RAS report file is always from upstream to downstream order 
irrespective of the RS order in the output data.  In order for RASPLOT to extract the data properly 
from both the input and output data the RS order must be from upstream to downstream order for 
both input and output data. 
 
 The order of the RS is controlled by the option Table Cross Section Order under Options menu 
in the Profile Output Table window.  If HEC-RAS is opened through the RASPLOT program, it 
will automatically select the RS order as upstream to downstream order. 
 
From the Profile Output Table window in HEC-RAS: 

• Click Options menu 
• Select Table Cross Section Order from the displayed options.   

The following dialog box will be displayed. 
 

  
 

• If the cross section order selected is from Downstream to Upstream order (HEC2 
Style), change the selection to Upstream to downstream order. 

• Click OK. 
• Close the Profile Output Table window.   
• Rerun HEC-RAS.  If the plan shown is not the desired one, select a different plan and 

rerun HEC-RAS. 
 
1.7 HEC-RAS Report File for RASPLOT 
 
This section explains how to create a report file in HEC-RAS for the RASPLOT program.  The 
following instructions can be used as the continuation of the previous section, or it can be used 
independently if the report file is to create from HEC-RAS directly.  If that is the case, the user 
must make sure that the HEC-RAS User Tables menu has a RASPLOT table and the Table Cross 
Section Order is from upstream to downstream. 
 

1. From the HEC-RAS main window, click File menu. 
 
2. From the list of displayed options, click Generate Report.  The following window 

should be displayed. (Except nothing is displayed under Selected Summary Tables 
box.  How to select RASPLOT will be explained later.) 
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 The following should be noted about the Report Generator window. 
 

• The Report File box will show “Asterisks for Borders.”  Do not change 
this option. 

• Under the Input Data area, the boxes for Plan Data, Geometric Data, and 
Reach Lengths will be checked.  Other boxes are not checked. 

• Under the Output area, the number of profiles shown under Profiles to 
Include in Report must be the same as the number of profiles in the Steady 
Flow Data window.  If you are unsure, click the Profiles… button in the 
Report Generator window and click the Select All button.  Then click the 
OK button. 
(The user must select all the profiles although not all the profiles are to be 
plotted.  The user will have a choice which profile(s) to be printed by using 
the Select Profile(s) option in RASPLOT.  See Section 3.4 Select Profile 
Dialog box.) 

• No boxes are checked under the Specific Tables (Detailed Output) area.  
(If the boxes are not checked as shown in the above figure, reselect the 
boxes.) 

• Search for RASPLOT in the Available Summary Tables box by scrolling 
through the pull down arrow. 

• Click RASPLOT to select.  RASPLOT will be displayed in the Selected 
Summary Tables box.  RASPLOT should be the only table in the Selected 
Summary Tables box.  If there are other tables in the Selected Summary 
Tables box, double click on the additional tables to delete them. 

 
3. Click Generate Report button. 
 
4. After the report is generated, click the Close button. 
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5. Click the Save button (second button from the left) from the HEC-RAS main 

window. 
 
6. Close the HEC-RAS main window. 

 
Proceed to Section 2.2, How to Create a Working  Table for HEC-RAS to create profiles in 
RASPLOT.  

  
1.8 Acknowledgements 

 
This program was developed by Dewberry for Federal Emergency Management Agency.  
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2.0 The Profile Table Database 
  

RASPLOT extracts data from HEC-RAS report file, HEC-2 input and output files, and user 
created database through RASPLOT to create a Working table in RASPLOT displaying the 
extracted variables.  How to create a Working Table for HEC-RAS, HEC-2, and non-HEC files 
and the extracted variables are explained in this chapter. 
 
2.1 What Is Profile Table Database?  

 
The Profile Table Database is an Access Database.  It has four tables: [Working], [Work Header], 
[Panel], and [Landmark].  This section explains in detail about the table [Working].  See 
Section3.5 Header Information for table Work Header, see Section 3.6 Panel Setup Information 
Dialog Box for table Panel, and see Section 3.7 Landmark Table for table Landmark. 

 
Please note:  The user should not modify the [Landmark], [Panel], or [Work Header] 
tables outside of RASPLOT.  In addition, the data inside the table [Working] should not 
be sorted.  To do so, may cause RASPLOT to malfunction. 

 
2.2 How to Create a Working Table for HEC-RAS 

 
This section explains how to create a working table in RASPLOT for HEC-RAS. 
. 

1. Run RASPLOT (double click the RASPLOT icon). 
 
2. From the RASPLOT Program window, click the Open button or click File menu 

and select Open command.  The following dialog box will be displayed.  (The files 
displayed will be the ones on the user’s computer).  

 

   
 

3. In the Open File window, as a default, HEC-RAS will be selected as the selected 
mode in the Select a model area.  Locate the folder where the HEC-RAS files reside 
by browsing through the folders in the right box.  All the HEC-RAS project files 
(files with extension “.prj”) in that folder will be displayed in the left box, as shown 
below. 
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4. Double click the HEC-RAS project file to be studied, or select the HEC-RAS project 
file and click OK.  The following window will be displayed. 

. 

 
 

5. From the RASPLOT Program window, click the Extract button.   
If the cross-section order in the RASPLOT user-defined table is from downstream to 
upstream, the following message will be displayed. 
 

 
 

• Click OK. 
• Close the RASPLOT window. 
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• Open HEC-RAS, correct the cross-section order (see Table Cross Section 
Order under Section 1.6.2, RASPLOT User Table), and regenerate the 
report file (see Section 1.7, HEC-RAS Report File for RASPLOT). 

• Save the HEC-RAS project and close HEC-RAS. 
• Follow the procedure from step 1. 

 
6. If the HEC-RAS project file does not include the Report File for RASPLOT (see 

Section 1.7), a message box stating that the Report File is missing will be displayed.  
Or, if the Report File does not include the RASPLOT user-defined table, a message 
box stating that the Report File does not have the right RASPLOT user-defined table 
will be displayed.  In either case, the message box will state that “You need to create 
the report file.” 
 

   
 

• Click the Yes button in the message box.  The HEC-RAS main window for 
the version that was selected (see Section 1.5, HEC-RAS Program Setup) 
will be displayed with the selected HEC-RAS project.   

• Follow the instructions in Section 1.7 HEC-RAS Report File for RASPLOT 
to create the report file. 

• After the report file is created, save the HEC-RAS project and close the 
HEC-RAS main window. 

 
7. Click the Extract button from the RASPLOT Program window.  RASPLOT will 

create a Working Table, as shown below, if the HEC-RAS file includes a single 
reach. 

 
 
 

See Section 2.5 for explanation of the Columns River, Reach, River Station, Structure, Length 
Chnl, Cum Dist, Min Ch El, Low Chord, High Chord, Label Letter, Label Text, Prof 1, Prof 2 … 
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See Section 3.0 Navigating in RASPLOT for a detailed explanation of the menus and the buttons.  
See Section 3.2 River/Reach Connection Dialog Box for HEC-RAS models with multiple streams 
and/or reaches. 
 
2.3 How to Create a Working Table for HEC-2 

 
You will need to open a HEC-2 input file on your computer hard disk or on a network by clicking 
File Menu and selecting Open command or by clicking Open Button. 

 
In the Open File Dialog box, select HEC-2 from the ‘Select a Model’ box.  Then select the Drive 
where the desired input file is located.  In the folder list, double-click folders until you open the 
folder that contains the input file you want.  Select the input file and click the “OK” button or 
double click the input file. 
 
If you can’t find the HEC-2 input file in the folder list, please see note below. 
 

Note:  To open a HEC-2 input file with a different extension than the default for a 
particular model, click the file type you want, and then double-click the input file name 
in the folder list. You can also type the extension in the File Type box; for example, type 
*.HC2 to find HEC-2 input files with the HC2 extension. 

 
Once the Input file is selected, RASPLOT will run the HEC-2 program.  Click on the “Extract 
Data” button and a profile table will be created. 
 
Supercritical HEC-2 files 
For engineered channels a supercritical flow analysis is allowed for the flood insurance studies.  
The HEC-2 program recognizes as a supercritical HEC-2 file if 1 is in the 4th field of J1 record.  
The starting cross section in the supercritical HEC-2 file is from the most upstream location and 
the cross sections are arranged in the upstream to downstream direction.  The output information 
is also in upstream to downstream direction.  For supercritical HEC-2 files, RASPLOT will 
rearrange internally the results and plot the profile from downstream to upstream direction.  
 
2.4 How to Create Working Table for non-HEC-RAS or non-HEC-2 hydraulic models? 
 
You will need to open a folder on your computer hard disk or on a network by clicking File Menu 
and selecting Create Blank Database command. 
 
Select the Drive where you want the file to be located.  In the folders list, double click folders 
until you open the folder you want the file to be located.  Type the primary name of the database 
file in the “File Name” box and click the “OK” button.  RASPLOT will assign ‘.mdb’ as an 
extension to the newly created Profile Table. 
 
Type number of profiles to be plotted in the pop-up window. 
 
Open the table using Microsoft Access, and insert the data into table “Working” 
 

Please note:  The user should not modify the Landmark, Panel, or Work Header Tables 
outside of RASPLOT.  In addition, the data inside the table “Working” should not be 
sorted.  To do so, may cause RASPLOT to not function properly. 
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2.5 Working Table 
 
The Working Table includes the columns, river, reach, river station, structure, length chnl, cum 
dist, min ch el, low chord, high chord, label letter, label text, and profile numbers. 
 
River 
This is the river name from the HEC-RAS Report File.  For HEC-2  the default is “1”.  Any letters 
or numbers can be entered in this column.   
 
Reach 
This is the reach name of the given river from the HEC-RAS Report File.  For HEC-2 the default 
is “1”.  Any letters or numbers can be entered in this column. 
 
River Station 
This is the River Station from HEC-RAS or the  SECNO from HEC-2 file.  Every entry in this 
column must be numerical.  Letters must not be entered. 
 
Structure 
The type of structure, such as bridge, culvert, and inline weir, is shown under this column. 
Please use: 

BRIDGE-Up or BRIDGE-Dn for Bridges 
CULVERT-Up or CULVERT-Dn for Culverts 
INLINE-Up or INLINE-Dn for Inline Wiers 
LID-Up or LID-Dn for long culverts and for culverts in series 

 
HEC-RAS 

BRIDGE-UP is labeled at the River Station where the bridge upstream 
internal section is located. Bridge BRIDGE-DN is labeled at the River Station where the bridge downstream 
internal section is located. 
CULVERT-UP is labeled at the River Station where the culvert upstream 
internal section is located. Culvert CULVERT-DN is labeled at the River Station where the culvert downstream 
internal section is located. 
INLINE-UP is labeled at the River Station for the upstream face of the weir 
where the inline weir profile data is specified. Inline Weir INLINE-DN is labeled at the same River Station for the downstream face of 
the weir. 
If the bridge is within the left and right channel bank stations the word 
‘Bridge #*-Up’ is labeled  for the bridge upstream internal section at the 
River Station where the Multiple Opening is modeled. Multiple   

Opening*   If the bridge is within the left and right channel bank stations the word 
‘Bridge #*-Dn’ is labeled for the bridge downstream internal section at the 
River Station where the Multiple Opening is modeled. 

* represents the number assigned to the bridge within the channel bank stations by the HEC-RAS program. 
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HEC-2 
The word ‘Bridge-Up’ is labeled at the cross-section immediately upstream 
(Section 3) of Special Bridge card.  An additional cross section is inserted by 
the RASPLOT program with the same section number as Section 3 and labeled 
as ‘Bridge-Dn’. 

Special 
Bridge 

In some situations, inline weirs, dams, and culverts, are modeled as the Special 
Bridge routine in HEC-2.  To change the type of structure, the name of the 
structure in the Profile Table should be changed according to the following: 
 

• For culvert, replace BRIDGE-Up with CULVERT-Up and 
BRIDGE-Dn with CULVERT-Dn. and also check that low 
chord elevations of the culvert with the value given for the 
bridge under low chord column. 

 
• For Inline weir and Dam, replace BRIDGE-Up with INLINE-

Up and BRIDGE-Dn with INLINE-Dn and remove the low 
chord elevation of the bridge from the low chord column. 

Special 
Culvert 

RASPLOT creates two additional cross sections for Special Culvert routine.  
One is for the culvert upstream internal section and labeled as ‘Culvert-Up’ and 
the other is for the culvert downstream internal section and labeled as ‘Culvert-
Dn’.  The same section number for Section 3 of the Special Culvert routine is 
assigned for these sections. 
The word ‘Normal’ is labeled for structures that are not modeled as Special 
Bridge or Special Culvert routines.  The word ‘Normal’ is labeled at the cross 
sections with BT or X2 records. 

Normal 
Bridge 

In some situations, inline weirs, dams, culverts, and bridges are modeled as the 
Normal Bridge routine in HEC-2 To change the type of structure, the name of 
the structure in the Profile Table should be changed according to the following: 
 

• For bridge, replace ‘Normal’ with BRIDGE-Up and 
BRIDGE-Dn and check the low chord elevations of the bridge 
with the values given in the low chord column. 

 

• For culvert, replace ‘Normal’ with CULVERT-Up and 
CULVERT-Dn and check the low chord elevations of the 
culvert with the values given in the low chord column. 

 

• For Inline weir and Dam, replace ‘Normal’ with INLINE-Up 
and INLINE-Dn and remove the low chord elevation from the 
low chord column. 

 
Length Channel (LENGTH CHNL) 
This is the length of the channel at the River Station from the downstream cross section. 
 

HEC-RAS 
Length channel is obtained from the user table RASPLOT except, for the culvert and inline weir. 

Culvert 

The length of the cross-section at Section 3 is equal to the Upstream Distance 
from culvert data. The length of the cross-section at Culvert-Up section is equal 
to the length of the culvert.  The length of the cross-section at Culvert-Dn section 
is computed by subtracting the summation of Upstream Distance and the culvert 
length from the channel length at Section 3.  Channel length at Section 3 is 
obtained from the cross sectional data in the HEC-RAS Report file. 
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Inline Weir 

The length of the cross-section at Section 3 is equal to the Distance from 
Deck/Roadway data.  The length of the cross-section at Inline-Up section is 
equal to the Width from Deck/Roadway data.  The length of the cross-section at 
Inline-Dn section is computed by subtracting the summation of Distance and 
Width from the channel length at Section 3.  Channel length at Section 3 is 
obtained from the cross sectional data in the HEC-RAS Report file. 

 
HEC-2 

Length  channel is obtained from the SUMMARY Table, column XLCH, except for the Special 
Culvert routine. 

Special 
Culvert 

The length of the cross-section at Culvert-Up section is equal to the length of 
the culvert and is obtained from the SC record in the input file.  RASPLOT 
subtracts the culvert length from the channel length at Section 3 and divides by 
two. This length is assigned as the channel length at Section 3 and the channel 
length at Culvert-Dn section.  The distances at the culvert cannot be zero or a 
negative number. 

Special 
Bridge 

The channel length at Bridge-Up section is equal to the channel length at Section 
3.  RASPLOT assigns a value of zero as channel length at Bridge-Dn section. 

 
Cumulative Distance (CUM DIST) 
 

Cumulative distance is computed by the RASPLOT program by adding the Length Channel 
values from a downstream to an upstream direction. 
 
Minimum Channel Elevation (MIN CH EL) 
 

This is the lowest ground elevation within the channel bank stations. 
 

HEC-RAS 
Minimum Channel Elevation is obtained from the Min Ch El column from the user table 

RASPLOT except for the culvert, inline weir, and multiple opening. 

Culvert 
Minimum Channel Elevation at the Culvert-Up and Culvert-Dn section is equal 
to the culvert invert elevation, and it is obtained from the culvert data in the 
HEC-RAS Report file. 

Inline Weir 

Minimum channel elevation at the Inline-Up section is equal to the minimum 
channel elevation at Section 3, and minimum channel elevation at the Inline-Dn 
section is equal to the minimum channel elevation at of the cross-section 
immediately downstream (Section 2). 

Multiple 
Opening 

RASPLOT first determines the type of structure within the channel bank 
stations.  If it is a bridge, the Minimum Channel Elevation is obtained from the 
user table RASPLOT.  If it is a culvert, the Minimum Channel Elevation is 
equal to the culvert invert elevation.  The type of structure is obtained from the 
Multiple Opening data in the HEC-RAS Report file. 

 
HEC-2 

Minimum Channel Elevation is obtained from the SUMMARY Table, ELMIN column except 
for the culvert. 

Culvert 
Minimum channel elevation at the Culvert-Up section is equal to the ELCHU 
value from the SC record, and minimum channel elevation at the Culvert-Dn 
section is equal to the ELCHD value from the SC record. 

 
Low Chord 
 

For the bridge, this is the elevation of the low chord.  For the culvert, this is the elevation of the 
crown of the culvert.  For inline weirs and dams, low chord elevation is assumed to be equal to the 
Minimum Channel Elevation. 
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HEC-RAS 

Bridge 

The ground station with the minimum channel elevation between the channel 
bank stations of the bridge internal section is first determined by the RASPLOT 
program, then the low chord elevation at this station is determined from the 
Deck/Roadway data.  Low chord elevation is determined in this manner for both 
Bridge-Up and Bridge-Dn sections. 
For a single culvert, the low chord elevation is computed by adding the Rise to 
the culvert invert elevation.  Low chord elevation is determined in this manner 
for both culvert-Up and Culvert-Dn sections. Culvert For multiple culverts, RASPLOT selects the culvert with the centerline station 
nearest to the ground station with minimum channel elevation.  Then low chord 
elevation is determined in the same manner as the single culvert. 

Multiple 
Opening 

RASPLOT first determines the type of structure within the channel bank 
stations.  If it is a bridge, then the procedure to determine the low chord for the 
bridge is followed.  If it is a culvert, then the procedure to determine the low 
chord for the culvert is followed. 

 
HEC-2 

Special 
Bridge 

The low chord elevation from the X2 record is used.  The same value is used for 
both Bridge-Up and Bridge-Dn sections. 

Special 
Culvert 

The low chord elevation for Culvert-Up section is computed by adding the Rise 
to the ELCHU value and the low chord elevation for Culvert-Dn section is 
computed by adding the Rise to the ELCHD value. 

Normal 
Bridge 

The ground station with the minimum channel elevation between the channel 
bank stations of section 3 and 4 of normal bridge routine is first determined by 
the RASPLOT program.  Then the low chord elevation at this station is 
determined from the BT and X2 data. 

 
High Chord 
 

For all the structures, the ground station with the minimum channel elevation between the channel 
bank stations is first determined by the RASPLOT program.  For HEC-RAS, the high chord 
elevation at this station is determined from the Deck/Roadway data.  High chord elevation is 
determined in this manner for both Upstream and Downstream sections.  For HEC-2, the high 
chord elevation at this station is determined from the BT or X2 data. 
 
The RASPLOT creates the profile along the center line of the stream.  The centerline of the stream 
is assumed to follow the minimum channel elevation between the channel bank stations.  The high 
chord and low chord elevations shown in RASPLOT are at the location where the stream 
centerline crosses the structures.  The user needs to review the FIRM and\or the model to 
determine the type of flow at the structure.  The profile should not be used to determine the type 
of flow. 
 
Label Letter 
 

This column is used to place letters at various River Stations on the profile.  For a given River 
Station, type the letter you wish to show.  No more than three letters or numbers can be shown in 
this column. 

 
Label Text 
 

This column is used to place a label at any River Station on the profile.  For example, corporate 
limits, road names, confluence of stream, etc., can be placed in this column. 
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Profiles 
 

Water-surface elevations of the profiles from HEC-RAS, HEC-2, or user inserted values are 
shown in these columns. 

 
HEC-RAS 

Water-surface elevations for the selected profiles are obtained from the RASPLOT user table, 
except for the culvert and the inline weir. 

 
Culvert The water surface profile through the culvert is selected by the RASPLOT 

program, depending upon the type of flow: 
 

• If the type of flow is low flow, the water-surface elevation at 
the Culvert-Up section is equal to the Culv WS In value from 
the RASPLOT table, and the water-surface elevation at the 
Culvert-Dn section is equal to the Culv WS Out value from 
the RASPLOT table. 
 

• If the type of flow is pressure flow, the water-surface 
elevation at the Culvert-Up section is equal to the water-
surface elevation at Section 3, and the water-surface elevation 
at the Culvert-Dn section is equal to the Culv WS Out value 
from the RASPLOT table. 
 

• If the type of flow is weir flow, the water-surface elevation at 
the Culvert-Up section is equal to the water-surface elevation 
at Section 3.  The water-surface elevation at Culvert-Dn 
section is obtained by adding the depth of weir flow over the 
upstream Deck/Roadway profile to the downstream high 
chord elevation. 

Inline Weir The water-surface elevations at the Inline-Up and the Inline-Dn are equal to the 
water-surface elevation at Section 3. 

 
HEC-2 

Water-surface elevations for the selected profiles are obtained from the SUMMARY Table 
except for the culvert. 

Culvert The water-surface elevation at Section 3 is used at Culvert-Up and Culvert-Dn 
sections. 

Inline Weir The water-surface elevations at the Inline-Up the Inline-Dn are equal to the 
water-surface elevation at Section 3. 

 
Drawdown 
Drawdown is defined as a situation where the upstream water-surface elevation (WSEL) is lower 
than the downstream WSEL.  For flood insurance studies drawdowns should be eliminated from 
the profiles.  RASPLOT will eliminate the drawdown by drawing a horizontal line from the 
downstream WSEL until it intersects with the original profile, thus removing the upstream WSEL 
that is lower than the downstream WSEL. 
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3.0 Navigating in RASPLOT 
  

This chapter explains the Menu Bar and Tool Bar in the RASPLOT program, how to select river 
and reaches from a stream network with multiple rivers and reaches, how node names from HEC-
RAS are displayed, how to assign backwater elevations, how to select profiles if the Working 
table has multiple profiles and only some profiles are to be plotted, what data should be entered in 
the Header Information, how to tailor the panel information, how to insert horizontal or vertical 
notes, what HEC-RAS project information is stored, and how the structure and stream bed 
symbols are displayed. 

 

3.1 RASPLOT Program Window 
 

This window has the Menu Bar and the Tool Bar as shown in the following figure. 
 

 
 
3.1.1 File Menu 
The File menu includes the following commands: 
 

Open This command opens the ‘Open File’ dialog box to select HEC-RAS 
or HEC-2 files or to open an existing Profile Table Database. 

Extract Data This command extracts data of the currently selected HEC-RAS 
project file or HEC-2 input file. 

Print Data This command prints the RASPLOT profile table. 
Save Database This command saves the open profile database file. 
Save DXF File This command creates a DXF file. 

DXF Editor This command opens the DXF editor program. 

Setup Program This command opens a dialog box that allows the user to locate 
ras.exe, hec2.exe files, and set-up a default directory. 

Create Blank 
Database 

This command creates a user defined database to be used for non-
HEC-RAS or non-HEC-2 hydraulic models. 

Exit This command exits RASPLOT. 
 

3.1.2 View Menu 
The View menu includes the following commands: 
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HECRAS 
Project Info 

This command displays the following information about the 
HECRAS project file:   

• Title of the Project file and its original path 
• Title of the Plan file and its original path 
• Title of the Geometry file and its original path 
• Title of the Flow file and its original path 
• Project description 

Zoom In This command allows you to draw a window around an area you wish 
to view at a closer scale. 

Zoom Out This command allows you to reduce the picture size by 10%. 
Full Extent This command allows you to restore the profile to its original size. 

 
3.1.3 Edit Menu 
The Edit menu includes the following commands: 

 

Setup Profile 
This command opens the ‘Select Profile(s)’ dialog 
box and allows the user to select the profiles from 
current profile database. 

Setup Backwater 
This command opens the ‘Backwater Setup’ dialog 
box and allows the user to enter backwater 
elevations for each selected profile. 

Setup Stream 

This command will display the ‘River/Reach 
Connection’ diagram window and allows the user to 
select the stream or reaches to plot the profile.  This 
command is only available for HEC-RAS project 
files with multiple streams and reaches. 

Re-compute Cumulative 
Distance 

This command allows the user to re-compute the 
cumulative distances in the profile database if the 
starting cumulative distance is to be changed or if a 
cross section is added or deleted or the channel 
length at a cross section is changed. 

Edit Database This command allows the user to view and/or edit 
the Profile Table Database. 

Edit Title Info 
This command allows the user to edit and change 
the community, county, state, and stream names, 
and the stream distance. 

Edit Panel Info 

This command displays the ‘Panel Setup 
Information’ dialog box and allows the user to 
modify the following: 

Starting Station, Ending Station, Unit, 
Horizontal Scale, Vertical Scale, 
Horizontal offset of each panel, and 
Vertical offset of each panel. 

Edit Landmark 

This command displays the ‘Landmark Table’ 
window and allows the user to insert horizontal or 
vertical notes at any point on the profile.  This is not 
limited to cross-section locations. 

Paneling/Plotting This command allows the user to view the Profile 
Plot window 

 
3.1.4 Help Menu 
The Help Menu provides the user with the following options.  

 

About 
“About” gives the user information about 
RASPLOT and the computer’s “System 
Information.” 



 

 
 

23

Online Help 
Online Help allows the user to access RASPLOT 
Hypertext Help file for help and definitions of 
RASPLOT functions. 

 
3.1.5 Status Bar 
This bar displays the current program and the cumulative distance and corresponding 
elevation of the point where the mouse pointer is located. 

 
3.1.6 RASPLOT Toolbar 
The RASPLOT toolbar contains the following: 

 

Open 
This button opens the ‘Open File’ dialog box to 
select HEC-RAS or HEC-2 files or to open an 
existing Profile Table Database. 

Save This button allows the user to save the RASPLOT 
profile database. 

Extract Data This button extracts data after you select HEC-RAS 
project file or HEC-2 input file. 

Data This button opens allows the user to view table 
“Working” from the RASPLOT database. 

Plot This button opens the Profile Plot Window. 

Panel Info* 

This button displays the ‘Panel Setup’dialog box 
and allows the user to modify the following: 

Community Name, County Name, State, 
Stream Name, Stream Distance, Starting 
Station, Ending Station, Unit, Horizontal 
Scale, Vertical Scale, Horizontal offset of 
each panel, and Vertical offset of each 
panel. 

Zoom In* This button allows you to draw a window around an 
area you wish view at a closer scale. 

Zoom Out* This button allows you to reduce the picture size in 
order to see the entire profile. 

Full Extent* This button allows you to restore the profile to its 
original size. 

DXF* This button creates a DXF file. 
*These buttons are not available until the profile plot window is open. 
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3.2 River/Reach Connection Dialog Box 

 
The multiple streams and reaches for a Plan in HEC-RAS is shown in the following figure, as an 
example. 
 

 
 
For HEC-RAS models with multiple streams and/or reaches, the following window will be 
displayed after the data is extracted from the HEC-RAS Report File by the RASPLOT program.  
(See Section 2.2 How to Create a Working Table for HEC-RAS). 
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• Click File menu 
• Click Select From List from the displayed options. 

The following dialog box, shown as an example, with all the streams and reaches in the HEC-
RAS Plan will be displayed in the left box. 
 

 
 
In the above example, if the Center Branch is to be plotted as one continuous profile the user must 
select the most downstream stream segment (reach) first by clicking the stream and reach name 
and click the ‘ > ’ button.  The selected stream segments will be shown in the right box as shown 
in the following figure. 
 

 
 
• Click the OK button.  
 
As an example, the following Working Table window will be displayed for the selected stream 
and reaches. 
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• Click the Plot button. 
As an example, the following window will be displayed. 
 

 
 
• Review the connectivity of the profile between the selected reaches. 
 
• If it is satisfactory, click the Data button to get back to the Working Table window and 

prepare the following to create a DXF file for the selected reaches. 
 
• If the lettered sections and the structure names are not in the Node Names table in HEC-RAS 

(see Section 3.3 Node Names from HEC-RAS) add the lettered sections under Label Letter 
column and structure names under Label Text column in the Working Table window.   

 
• Add back water (see Section 3.4 Backwater Setup Dialog Box) if applicable. 
 
• Select 10%, 2%, 1%, and 0.2% annual chance flood profile names (see Section 3.4 Select 

Profile Dialog Box) if the number of profiles is not equal to four and\or the sequence of 
floods in the HEC-RAS flow file are not from the more frequent floods to less frequent 
floods.  For example, the flow file may have floods shown in the order of 1%, 10%, 2%, and 
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0.2% annual chance floods.  In that case, the user needs to assign the correct flood profile 
names to the profiles from Select Profile Dialog box. 

 
• Select Header Information (see Section 3.5 Header Information). 
 
• Select panel scheme (see Section 3.6 Panel Setup Information Dialog Box). 
 
• Save as DXF file (see Section 3.3 Node Names from HEC-RAS).. 
 
Selection of Another Stream 
To select another stream or the combination of other stream lines: 
• Click Edit menu in the RASPLOT Program window. 
 

 
  
• Point to Select River Reach and click Select River/Reach From List. 
 
As an example, the following dialog box will be first displayed with all the streams and reaches in 
the HEC-RAS Plan on the left box.  The user then selects another stream and reach by first click 
on the stream and the reach and click on the ‘ > ’ button.  The selected stream(s) and reach(es) 
will be displayed in the right box. 
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• Click the OK button. 

Follow the same procedure as described before to create the DXF file for the newly selected 
stream and the reach. 

Second Alternative 

For the HEC-RAS models with multiple streams and\or reaches the following window will be 
displayed after the Extract button is clicked in the RASPLOT Program window. 

 
• Use the cross hair and click on the stream segments to be combined as a continuous profile.  

Click the most downstream stream segment first. 

• Click File menu and click List Selection from the displayed options. 

The selected stream and reaches from the previous step will be displayed as shown below. 

 
• Click the OK button. 

• Click the File menu and click Exit from the displayed options. 

The Working Table window will then be displayed. 
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3.3 Node Names from HEC-RAS 

  
This section explains how RASPLOT extracts node names from HEC-RAS and places them under 
the Label Letter column for the lettered cross sections and under the Label Text column for the 
structures in the Working Table.  The following procedure can be applied to HEC-RAS versions 
with the option for Node Names. 

 
1. From the HEC-RAS main window, click the Geometric Data button (third button 

from the left in HEC-RAS Version 3.1.2).  
 

 
 

The following window will appear. 
 

 
 

2. Click the Tables menu. 
 
3. From the list of displayed options, click Node Names.  
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. 

 The following window will appear.  (It will be blank when it first appears.) 
 

 
 
In order for RASPLOT to differentiate between the lettered cross section and structure 
name, type in upper case up to three letters for cross sections and any name (upper or 
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lower case) up to 16 characters for the structure name at the desired River Stations under 
the Node Name column.  The final product from the DXF editor in RASPLOT will 
display in upper case for both the cross sections and the structures. 

 
(The user must type in the lettered sections from downstream to upstream direction, and 
they must be in alphabetical order.  RASPLOT will not check the order of the letters.  If a 
structure name has only three letters, such as “Dam,” at least one letter must be in lower 
case for RASPLOT to differentiate the name as a structure.  Please note that “Garden 
State Parkway” was cut off at “Par” because of the 16 characters limitation in HEC-RAS.  
The user can edit the names in RASPLOT after the Node Names are extracted.)   

 
4. Click the OK button.  
 

Please refer to Section 1.7 HEC-RAS Report File for RASPLOT to generate a report file for 
RASPLOT from HEC-RAS.  After generating the report, please refer to Section 2.2 How to 
Create a Working Table for HEC-RAS to create profiles in RASPLOT.  If the HEC-RAS file 
includes multiple rivers and reaches, please refer to Section 3.2 River/Reach Connection Dialog 
Box to select, one at a time, the rivers and/or reaches to create a continuous profile for a single 
stream in RASPLOT. 
 
After the procedure in Section 2.2 or 3.2, RASPLOT will display the Working Table with the data 
extracted from HEC-RAS, as the continuation of the above HEC-RAS window, as shown in the 
following figure. 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

 
 
Please note that lettered cross sections are placed under the label letter column and the structure 
names are placed under the label text column.  As a default, the structure names at the structures 
are placed at the downstream section of the structures.  This arrangement allows RASPLOT to 
display the name of the structure on the left side of the vertical line at the structure in DXF Editor 
(see Chapter 4.0 DXF Editor).  The user must not change the location of the names in the 
Working Table window; however, the user can move the location of the names in the DXF Editor.  
The name of the structures, such as “Garden State Par” can be edited as “Garden State Parkway” 
in the Working Table window. 

  
The following is a brief demonstration of the steps that can be taken to visualize the final product 
related to the lettered cross sections and the structure names using DXF Editor.  (The user must 
read the other sections to create a complete profile database before creating a DXF file). 
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First, the structure name “Garden State Par” is corrected to “Garden State Parkway” in the 
Working Table, as shown below. 

  

  
  

1. Click the Plot button.  The following window will be displayed. 
  

 

 
  

The above window shows the overall layout of the profiles, structures, lettered sections, 
and panels. 

  
2. Click the DXF button to create a dxf file.  The following window will be displayed. 
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Locate the folder where the dxf file will be stored.  Type in the primary name of the  dxf 
file in the Filename box. (The extension dxf will be appended automatically). 

 
3. Click the Save button. 

 
4. Click the File menu from the RASPLOT Program window. 

  

  
  

5. From the list of displayed options, click DXF Editor.  As a default, DXF Editor will 
extract the data from the saved dxf file from the previous step, and the following 
window will be displayed. 
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6. Click on the Zoom Window button (7th button from right on the horizontal button 
bar).  A Cross-hair line symbol will appear.  Drag the symbol and encompass the 
panel to view.  The following is an example of the selected panel. 

 

  
  

7. Use the Zoom Window button or click the Zoom In button (3rd button from right 
on the horizontal button bar) to zoom in on the name of the structure and the lettered 
sections.  The following figure is shown as an example for the name of the 
structures.  

  



 

 
 

35

  
  

Please note that the names of the structures are displayed in upper case.  The following 
figure shows the letters displayed in the hexagon. 

  
  

  
  

8. Click the File menu. 
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9. From the displayed options, click Exit.  The following dialog box will be displayed. 
  

   
  

10. Click the No button in this case because a full-fledged profile database has not yet 
been created. 

 
11. Close the RASPLOT program window. 

  
3.4 Backwater Setup Dialog Box 

 
Backwater Setup command in Edit Menu will open the “Backwater Setup” dialog box.  Enter 
backwater elevations for the corresponding profile.  Once backwater elevations are entered click 
the “OK” button. 
 

 
 
3.4 Select Profile Dialog Box 

 
Select Profile command in the Edit Menu which will open the “Select Profile(s)” window and 
allows you to select the profiles to be printed. 
 
The “Select Profile(s)” window shows a list of the available profiles.  Use the double forward 
arrows (>>) to select all the profiles to be printed.  Otherwise, click on one profile at a time and 
use the single forward arrow (>) to select the profiles you want to print.  If you change your mind 
and do not want to print that profile click on the profile and select the single backward arrow (<).  
If you do not want to print all the profiles use the double backward arrows (<<).   
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To Change the name of a profile, click the profile and use the drop down window at the bottom of 
the screen to change its name.  For example, if Profile 1 is labeled 10 Year Flood, and it should be 
100 Year Flood, first click on 10 Year Flood and then select 100 Year Flood from the drop down 
window. 

 

  
 

3.5 Header Information 
 

The following information can be changed by either clicking “Edit” and “Edit Title Info,” “Edit” 
and “Edit Panel Info”, or the “Panel Button.” 

 

Community Name 
Type the name of the community.  For Counties and/or County 
Wide Studies, type the County name.  For example, “Village of 
Northbrook” or “Cook County” 

County Name Type the name of the County.  For Counties, type 
“Unincorporated Areas” or “Incorporated Areas” as appropriate. 

State Name Type the 2 letter abbreviation for the State.  For example, “VA” 
for Virginia, “IL” for Illinois, etc. 

Stream Name Type the Name of the Stream. 
 

Stream Distance 

Type where the stream’s channel distance is measured from.  
For example, “ABOVE CONFLUENCE WITH DEWEY 
RIVER,” or “ABOVE MOUTH.”  When the DXF file is 
created, RASPLOT will add “STREAM DISTANCE IN” and 
selected unit (i.e., “STREAM DISTANCE IN FEET ABOVE 
MOUTH”. 
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3.6 Panel Setup Information Dialog Box 

 
Panel Info command in the Edit Menu or the Panel button will open the Panel Setup Information 
dialog box. 
 
The user can view and edit the Community Name, County Name, State, Stream Name, Stream 
Distance, Starting Station, End Station, Panel Starting Elevation, and Ending Elevation of each 
panel.  If the user wants to reduce the length of the first panel retype the end station.  Same station 
should be retyped as the starting station of the next panel.   
 
The user is given the option of plotting the profile in different units.  “Feet”, “Hundred Feet”, 
“Thousand Feet”, “Mile”, “Meters”, and “Kilometers” are available for use. 
 
The user can view and edit the Horizontal Scale and Vertical Scale of each panel.  For units of 
Feet, the horizontal scale of 100, 200, 400, 500, 1000, and 2000 feet and vertical scale of 5, 10, 
and 20 feet are given in the pull down window.  Use the pull down windows to select both 
horizontal and vertical scales.  For the units of Miles, in order to calculate the horizontal scale, use 
the formula, Horizontal Scale = Desired Interval * 5280 (i.e., 528 = 0.1 * 5280).  The user needs 
to type horizontal scales of 528, 1056, and 2640 feet in order for the horizontal labels to be 
exactly 0.1, 0.2, and 0.5 mile, respectively. When selecting Meters or Kilometers, RASPLOT 
assumes the input from HEC-2 and HEC-RAS is in meters. 
 
Only Vertical scales can be changed for individual panels. 
 
The user can select the Vertical Datum between NAVD 88 and NGVD 29 from the Vertical 
Datum box using the pull down arrow. 
 
The user can select between New and Old legend from the Legend Option box using the pull 
down arrow.  If the New legend is selected it will be seen in the DXF Editor as shown below. 
 

 
 



 

 
 

39

X and Y Origins allows the user to move the panel vertically, or horizontally.  For example, for a 
vertical scale of 5, reduce the existing number by 10 in the Y Origin column for a selected panel 
and click OK.  The panel will move up 2 inches. 

  

    
 
 

 
 

3.7 LandmarkTable 
 

The ‘Landmark Table’ dialog box allows the user to insert horizontal or vertical notes at any point 
on the profile.  This is not limited to cross-section locations. 
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To automatically insert the location of a note, right click on the Profile Plot window and click on 
“Insert Landmark Point.”  Select the point on the Profile Plot window in which you desire to place 
a note.  RASPLOT will automatically add the cumulative distance and elevation you select. 
 
To Delete any point, select the row you desire to be deleted, and press the Delete key. 
 
The Landmark Table consists of the following columns: 
 

Cumulative Distance This is the horizontal starting point along the profile at which the 
user wishes the text to be located. 

Elevation Elevation at which the text is to be located. 
Text Text the user wishes to be printed. 

Orientation This field contains whether the user wants the text to be printed 
Vertically or Horizontally. 

Adjusted 
This field contains how the user wants the text to be oriented.  For 
Left Justified, select “L/B”, for Center Justified, select “Center”, and 
for Right Justified, select “R/T”. 

Underline This options allows the user to underline the text. 
 
 

 
 

3.8 HEC-RAS Project Information 
This window stores project information from the HEC-RAS project file into the RASPLOT 
Profile Database. 
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3.9 Structure and Stream Bed Symbols 
Structure Symbol 
RASPLOT will identify structures with different colors in the RASPLOT Program window when the Plot 
button is clicked.  The bridge is identified as a red vertical line, culvert is identified as a black box, dam 
(inline weir) is identified as a blue box attached to the channel bottom, and lid (HEC-RAS option) is 
identified as a blue box.  RASPLOT will indicate the River Stations where the lid option is used in HEC-
RAS as Lid under the structure column, as shown in the following figure. 
 

 
 
As an example, to indicate the type of structure, culvert, dam, lid, and bridge are shown as name of the 
structure under label text column. 
When the Plot button is clicked the following window will be shown. 
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Click the DXF button to create the DXF file. 
Click File menu and click DXF Editor. 
The following window shows the type of shading applied to each type of structure. 
 

 
 
The culvert and lid are shown in grey shading, dam is shown in opaque shading, and the bridge is shown as 
an I shape. 
 
Stream Bed Symbol 
Two stream bed symbols per panel will be inserted by the RASPLOT program as shown in the above 
figure.
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4.0 DXF Editor 
 

4.1 What is the DXF editor 
 

The DXF editor allows the user to view, modify and print DXF files.  It is a fully functional 
CADD program where the user can create, erase, trim, explode, rotate, scale, copy, move, and 
format objects.  In addition, the DXF editor allows the user to save any changes in either DXF or 
DWG formats which are AutoCAD 13/14/2000 compliant. 

 
4.2 Open an Existing DXF file 

 
By default, after the user creates a DXF file in RASPLOT, when the DXF editor is opened it will 
automatically open that DXF file.  However, you do not have to have RASPLOT create a DXF 
file in order to use the DXF editor.  To use the DXF editor, open RASPLOT, click “File” and 
“DXF Editor.”   
 
Click either “File” and “Open” or the “Open Button” to open the “Open” dialog box.  Under 
“Files of type:”, select either “AutoCAD files (*.DWG)” or “DXF files (*.DXF)”.  Browse the 
computer to locate the file of the selected file type.  Click the “Open button” to open the selected 
file. 

 
4.3 Save changes in DXF format 

 
If the drawing is named, RASPLOT saves the drawing under the specified name.  
If the drawing is unnamed, RASPLOT displays the “Save Drawing As” dialog box.  Enter a file 
name and save the drawing. 

 
By default, RASPLOT will save the drawing as a DXF file. 

 
4.4 Print the DXF file 

 
 From the “File” menu, click “Print”.  From the tool bar, click the “Print” button. 
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Select Plot Area 
 

  Pen Assignments   
This button Displays the Pen Assignments dialog box.  It sets the pen number and pen 
width associated with each color. 

 

  
 

Pen Assignments dialog box 
 Select the entry or entries to modify from the list. 

 
Modify Value 
Modifies parameters for pen and width. 

• Color 
• Pen 
• Width 
 

Use the >> button to determine which pen is assigned to a specific color. 
 
Pen Width 
Enter the line width to instruct the printer how many lines are required to fill a solid area.  
Some devices that do not have physical pens rely on the pen width to fill solid areas with 
lines. Pen width is not available for some plot devices. 

 
  Window 

Plots any portion of the drawing.  Chose the Pick < button to specify two corners of the 
area to be plotted by using the mouse to designate the window if the whole area you want 
to specify is visible on the screen. 
 

  Extents 
Plots the portion of the current space of the drawing that contains objects.  This option is 
similar to ZOOM Extents.   

 
Additional Parameters 
 
  Scaled to Fit 

Scales the plot so that the view chosen and the portion of the drawing to be plotted, is 
made as large as possible for the specified paper size.  When Scaled to Fit is selected, the 
text boxes display the actual scale used.  RASPLOT will update this scale whenever you 
make any entry that affects the scale.  When Scaled to Fit is turned off, the text boxes 
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default to 12 =12 except when the scale has been previously set to other values.  In that 
case, DXF Editor will display that scale in the text boxes. 
 
When millimeters are chosen, the label reads Plotted MM. = Drawing Units. 
When Inches are chosen, the label reads Plotted Inches = Drawing Units. 

 
  Origin X: / Origin Y: 

The plot normally begins in the lower-left corner of the paper (the home position).  Enter 
the plot origin in the X Origin and Y Origin boxes to place the plot origin at another 
location on the paper.  On some plotters you can use negative coordinates. 


